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Appendix 1- User’s guide for LIDAR based Stand Delineation

About this User’s Manual- This manual is designed for use with ArcMap 9.2. There are 
three additional software packages that can be downloaded for free from the world wide 
web. This user’s manual and required programs are designed for the Windows operating 
system.  

Programs Required: 
� ArcMap 9.2 
� SPRING 4.x 
� FUSION- Current Version 
� Hawth’s tools

Data:
� The data used in the tutorial is the FUSION example data.  It is available for 

download at http://forsys.cfr.washington.edu/fusion/fusionlatest.html
This data is courtesy of Robert J. McGaughey at the Forest Service Pacific 
Northwest Research Station. 
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Part I - Downloads:

1.1 SPRING- This software was developed by Brazil's National Institute for Space 
Research as a “a state-of-the-art GIS and remote sensing image processing system with 
an object-oriented data model which provides for the integration of raster and vector data 
representations in a single environment.” (SPRING website). SPRING is available for 
download in English at: http://www.dpi.inpe.br/spring/english/index.html.

To set up SPRING on your computer, please follow these steps. 

1. Go to http://www.dpi.inpe.br/spring/english/index.html and click on the 
“downloads” tab at the top of the page. 

2. On the “Download” page you will be asked to register before you can download 
the software. Please enter a valid email address and click on the “Subscribe” 
button.
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3. The following screen will appear, please fill out the required information and 

click

4. You will now be able to download the current version of SPRING. Go back to the 
download page and enter your email and password and choose the correct version 
for your operating system and click “Download.” 

Version
Selection
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5. From this screen choose the “Install.exe” from one of the download sites. Make 
sure to choose the version in English! 

6. Choose to “Save File” and specify where to save the install_spr433.exe file to. 

7. Once the file has downloaded, run the install_spr433.exe from the directory where 
it was saved. Click “Next” to start the install. 
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8. Click “Next” to accept the license agreement. 
9. Choose the directory where you would like to install SPRING, and click “Next” 

to start the install. 

10. Choose to only install the SPRING program, and click “Next.” 
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11. Click “Next” on the following screen and the install will begin. Once the install is 
complete, click on the “Finish” button and you will exit the install wizard. The 
SPRING program has a desktop shortcut or can be accessed through the Start-
>All Programs->SPRING. 

12. You have now completed the installation of SPRING. 

1.2 FUSION- FUSION was developed by Robert McGaughey at theUSFS Pacific 
Northwest Research Station. This program is primarily a viewing tool for LIDAR data, 
but also provides basic analysis that is important to the foundation of this project. The 
current version of FUSION can be found at: 
http://forsys.cfr.washington.edu/fusion/fusionlatest.html this website is updated by the 
developers of FUSION and will contain the latest public release of FUSION. 

1. From the webpage above, click on the “Install.exe” at the bottom of the page. 

Install.exe 
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2. Choose to save the file and choose the destination directory. 
3. Run the FUSION_Install.exe from the directory in which it was saved. Click on 

“Next” when this screen appears. 

4. Choose the directory you would like FUSION installed (Recommended to use 
defaults). Click “Next.” 
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5. Choose the Start menu folder you would like the FUSION shortcut to reside in, 
then click “Install” 
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6. This will start the install process, this may take several minutes. When it is 

finished, click “Finish” to exit the installation. 
7. You have now completed the install of FUSION. 

________________________________________________________________________

Hawth’s Tools- This program is a set of ecology analysis tools that are packaged as an 
extension for use in ArcMap. The software is free and can be downloaded at 
http://www.spatialecology.com/htools/download.php . This extension will be used later in 
the tutorial for accuracy assessment. 

To set up this extension: 

1. Go to the link above and click on “Download Hawth’s Tools.” Follow the 
installation instructions below. 

Installation Instructions: (From website) 
1. Download Hawth's Tools using the link below. Save the WinZip file to your hard drive 
(anywhere), and unzip it. (If you do not have a copy of WinZip, you can download it 
from http://www.winzip.com.)
2. Run the program called htools_setup.exe. (Note that this program can also be used to 
uninstall the software). 
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Part II- Generation of Raster Data

This portion of the manual is comprised of two sections. The first will lead you through 
the process of dealing with the raw LIDAR products and work within FUSION. The 
second section will focus on the analysis within ArcMap. The final products of this 
section will be three raster datasets that will then be used in SPRING. 

Section 1- Working with FUSION command lines

Software needed: 
� FUSION (see downloads section)

Data Required: 
� Ground Model (demo_4800K_UTM.dtm) 
� LIDAR points (demo_4800K_UTM.lda) 
� Aerial Photograph (demo_4800K_UTM.jpg and demo_4800K_UTM.jpgw) 

Click here to
Start download. 
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Data for this section: 
1. Download the example data from 

http://forsys.cfr.washington.edu/fusion/fusionlatest.html which is the same page 
where you downloaded the FUSION software. Click on example data. Make sure 
to download the UTM example data!

2. Choose “Run” or “Save” from the pop up menu, if you chose to save it, remember 
where you saved the file. 

Example data 
download
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3. Choose to download both components, and click “Next.” (maybe change this 

when Bob updates webpage)

4. Choose the directory to install the example data. Then click “install.” 

5. The install will run and when it is finished, click “finish” and you now have 
successfully downloaded the example data. The next portion of this section will 
be working with raw LIDAR points.
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Working with the FUSION batch files: 

This portion of the process will involve the use of command prompts and batch files. All 
of the batch programs are located in the C:\FUSION directory of the computer, unless 
otherwise specified during download. The default will be to run these programs out of the 
C:\FUSION directory, which will require all of the data that is called by the batch file to 
be in that directory, the outputs will also be put there. It is also possible to set the 
environmental variables on the machine to allow for data processing in other directories, 
this manual does not cover how to do this. The FUSION manual has detailed descriptions 
of each tool and the variables available. This manual will focus on the tools needed for 
this process. Make sure that the example dataset being used is in the UTM projection, this 
will cause problems later in the tutorial if using the incorrect datasets. All UTM datasets 
will have “UTM” somewhere in the file name. 

1.  Open a command prompt window from the Start menu, by selecting “Run” and 
typing “cmd” on the line.  

2. The command prompt window will open. At the prompt, type “cd c:\FUSION” 
and press “enter” to change the directory to the location of the batch programs. 

Choose “Run” from the 
Start menu 

This is the window that will 
open when you click on “Run” 
from the start menu. Type 
“cmd” to open a command 
prompt, and click “ok” 
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3. Now we are ready to work with the batch files in FUSION. The files that will be 
used in this step are the raw LIDAR points (demo_4800K_UTM.lda) and the 
bare ground model (demo_4800K_UTM.dtm). Make sure that these files are in 
the C:\FUSION directory on your computer. 

FUSION batch file tools: 
The tools need for this tutorial are described in the following section. The FUSION user’s 
manual gives a more complete description of the tool and the available switches. The 
tools are presented in chronological order for this method.  

1. Percent Cover Calculation: 

The first step is to use the Cover batch program in FUSION to create a percent cover 
estimation for the study area. The description from the FUSION user’s manual is:
“Cover computes estimates of canopy closure using a grid. Output values for cover 
estimates range from 0.0 to 100.0 percent. Canopy closure is defined as the number of 
returns over a specified height threshold divided by the total number of returns within 
each cell. In addition, Cover can compute the proportion of pulses that are close to a bare-
ground surface model to help assess canopy penetration by the laser scanner. With the 
addition of an upper height limit, Cover can compute the proportion of returns falling 
within specific height ranges providing estimates of relative vegetation density for 
various height strata.” (McGaughey, R.J., 2007). 

General syntax: 
Cover [switches] groundfile coverfile heightbreak cellsize xyunits zunits coordsys zone 
horizdatum vertdatum  datafile1 

The syntax that will be used for this data set: 
Cover  demo_4800K_UTM.dtm demo_cover_89916m_utm.dtm 2 8.9916 m m 1 10 2 2 
demo_4800K_UTM.lda 

Explanation of Syntax: The cell size of this analysis is based on 1/50 acre. 8.9916m by 
8.9916m is approximately 1/50th of an acre and a common area used in forest inventory. 
The data is in meters and projected in UTM NAD 1983  NAVD88 zone 10 north, which 
explains the rest of the syntax (see FUSION user’s manual for more information). 
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1. Copy and paste the syntax give above into the command prompt window and 

press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.

DTM2TIF Tool: 
The second step for the percent cover dtm will be to create a geo tiff file from the dtm. 
This will create the final product to be used in SPRING and will allow for the percent 
cover image to be viewed in ArcMap. This step will use the DTM2TIFF tool in FUSION. 
This tool will also be used to create the stem density and average height geo tiff files later 
in the tutorial.  

General syntax: 
DTM2TIF [switches] inputfile [outputfile] 

The syntax that will be used for this data set is: 
DTM2TIF demo_cover_89916m_utm.dtm demo_cover_89916m_utm.tif 

1. Copy and paste the syntax give above into the command prompt window and 
press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.

Explanation of Output: This generates a geo tiff file from the 
demo_cover_89916m_utm.dtm that was created in the previous step. There are two files 
output from this process, a tiff image file (.tif extension) and a world file (.tfw extension). 
Both files will have the same name but be distinguished by the extensions, any changes to 
the file name must be made on both files or the geo tiff will not function correctly. It is 
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important to note that BOTH of these files must be moved when moving this file 
around in order to preserve the functionality of the geo tiff.

2. Canopy Maxima- Generation of the canopy maxima points is a two step process that 
requires the use of the Canopy Model tool and the Canopy Maxima tool in FUSION. 

Canopy Model Tool- 
The second program that will be used in this process is the Canopy model tool. This tool 
uses the raw LIDAR points (demo_4800K_UTM.lda) and the ground surface model 
(demo_4800K_UTM.dtm) to create a model of the surface of the canopy. The ground 
model is used to “subtract the ground elevations from the return elevations to produce a 
canopy height model” (McGaughey, R.J., 2007). The canopy height model is an 
intermediate step to producing the canopy maxima points. 

General Syntax: 
CanopyModel [switches] surfacefile cellsize xyunits zunits coordsys zone horizdatum 
vertdatum datafile1 

The syntax that will be used for this data set: 
CanopyModel /ground:demo_4800K_UTM.dtm demo_canopyheight_UTM.dtm 1.5 m m 
1 10 2 2 demo_4800K_UTM.lda 

Explanation of Syntax: The ground switch is needed to create a canopy height model. 
The cell size is 1.5 meters, which is approximately 5 feet. The data is in meters and 
projected in  UTM NAD 1983  NAVD88 zone 10 north, which explains the rest of the 
syntax (see FUSION user’s manual for more information). 

1. Copy and paste the syntax give above into the command prompt window and 
press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.

Canopy Maxima Tool- 
The next step in FUSION is to generate the canopy maxima points using the Canopy 
Maxima tool. This tool uses a variable analysis window to identify local maxima points 
as well as information about crown height and width. The output of this process is a 
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comma separated value file (.csv) that will need to be manipulated in the FUSION 
GUI program before returning to the command line analysis. This process will be covered 
in subsequent sections. This tool uses the Canopy Height Model produced in the previous 
step.

* Note about Canopy Maxima* 
Methods for finding canopy maxima with LIDAR is a relatively new and changing 
process. The user should be aware that at the time of this manual being written, there are 
several tools that are available to find canopy maxima and depending on the purpose of 
the project, this tool may not be the best. The FUSION canopy maxima tool was chosen 
for this project and manual due to the availability of the tool and its ability to process 
large areas. However, this choice was made with the awareness that the canopy maxima 
tool underestimates the true maxima in forest stands. Currently, this tool will work well 
for either young stands or mature stands based on the parameters that are set. Mixed 
forest areas such as the example data pose a problem in that it will provide very good 
stem density information for one stand type and not the others. For more information 
about the methodology used in the Canopy Maxima tool see: 

Kini, A.U. &  Popescu, S.C. (2004, September, 16). Treevaw: A versatile tool for 
analyzing forest canopy LIDAR data- A preview with an eye towards the future.
Paper presented at the 2004 ASPRS Images to Decisions: Remote sensing for GIS 
applications conference, Kansas City, MO. 

With that said, this project is interested in creating a density layer that represents the 
densities of stands relative to one another, not an absolute count of trees per acre. The 
information generated about stem density in this method will not accurately represent the 
conditions on the ground, but will provide a data layer that will act as a relative measure 
of density between stands for the image segmentation in SPRING.  

General Syntax: 
CanopyMaxima [switches] inputfile outputfile 

The syntax that will be used for this data set: 
CanopyMaxima /mult:0.5 /threshold:2 demo_canopyheight_UTM.dtm 
demo_canopymaxima_utm.csv 

Explanation of Syntax: The choice of these switches and the values here are specific for 
this dataset. It is likely that for each data acquisition, there will need to be adjustments 
made to these values. The values were chosen for this dataset because it produced the 
best results for comparison of densities between stands (see note above).

1. Copy and paste the syntax give above into the command prompt window and 
press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.
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2. A file called demo_canopymaxima_UTM.csv will be located the C:/FUSION 
directory. This file contains the information for each canopy maxima pint. This 
file will be used in the next section to produce the stem density and average height 
data layers.

Section 2- Working with FUSION GUI

This section will be a brief departure from the FUSION command line interface used in 
the previous section. Once the needed files are created, the command lines will be used 
again to produce the final two data layers, stem density and average height.  

Software needed: 
� FUSION (see downloads section) 

Data Required: 
� Canopy maxima file from previous section (demo_canopymaxima_utm.csv) 

1. Open the FUSION GUI in Start -> Programs -> FUSION.

When the program opens go to the top menu bar and open Tools -> Data Conversion
-> Import generic ASCII LIDAR data.
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2. This will open a dialogue box for importing ASCII and CSV files. This tool will 
be used to create “point clouds” from the canopy maxima file that represent a flat 
ground model and the canopy maxima points. To do this, the canopy maxima .csv 
file must be converted into two .lda files.  

3. To create the flat ground model, click on the first “Browse” button and navigate to 
the demo_canopymaxima_utm.csv file. Click on the second “Browse” button and 
give the output file a name of “demo_flat_ground.lda” in the C:\ FUSION 
directory.

4. The next step is to set the parameters for the import of the data. In the “Start on 
import row” type 2. This will start the data below the column headers. In the 
“Column assignments” dialogue box Set X to “field 2”, Y to “field 3” and 
Elevation to “field 9” the remaining fields should be set to “none”. (Setting the 
elevation to field 9, or 0 will create a flat surface when taken through the future 
steps.) Click on “Import data” and then close when the import is complete.  
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5. Repeat this process for the canopy maxima points to create an .lda file for the 
canopy points. Open Tools -> Data Conversion -> Import generic ASCII LIDAR 
data.

6. Click on the first “Browse” button and navigate to the 
demo_canopymaxima_utm.csv file. Click on the second “Browse” button and 
give the output file a name of “demo_canopy_maxima.lda” in the C:\ FUSION 
directory.

7. The next step is to set the parameters for the import of the data. In the “Start on 
import row” type 2. This will start the data below the column headers. In the 
“Column assignments” dialogue box Set X to “field 2”, Y to “field 3” and 
Elevation to “field 5” the remaining fields should be set to “none”. (Setting the 
elevation to field 5, uses the height of the canopy maxima points) Click on 
“Import data” and then close when the import is complete.  

Start import on row 

This will create the  
.lda for the flat ground 
surface.
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8. The demo_flat_ground.lda and demo_canopy_maxima.lda files will now be used 
in the command line interface of FUSION for the final analysis.  

9. Open a command line as described in the previous section, and change the 
directory to C:\FUSION to start the next portion. 

1. Grid Surface Create: 

This tool will be used to produce the flat ground surface from the demo_flat_ground.lda 
file just created. The importance of this flat ground model relates to the next tool that will 
be used called Grid Metrics. Grid Metrics is generally used on raw LIDAR datasets and 
uses the ground model to normalize the data. Since the data has already been normalized 
through the production of the Canopy Height model, this is not necessary and the flat 
ground model is used as a trick to make the Grid Metrics tool work properly for this 
application.

General Syntax: 
GridSurfaceCreate [switches] surfacefile cellsize xyunits zunits coordsys zone 
horizdatum vertdatum datafile1 
The syntax that will be used for this data set: 
GridSurfaceCreate demo_flat_ground.dtm 8.9916 m m 1 10 2 2 demo_flat_ground.lda 

Start on import row 

This will create the 
.lda file for the 
canopy maxima 
points.
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Explanation of Syntax: The data is in meters and projected in UTM NAD 1983  
NAVD88 zone 10 north, (see FUSION user’s manual for more information). 

1. Copy and paste the syntax give above into the command prompt window and 
press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.

2. Grid Metrics: 

This tool will create the two final data layers; stem density per pixel and average height 
per pixel using the points from the demo_canopy_maxima.lda. This tool has several other 
functionalities that are detailed in the FUSION manual. For this exercise, the min points, 
and raster switches will be used. The final output will be two .dtm layers for mean and 
count that will be converted to geo tiff files using the DTM2TIF tool. 

General Syntax: 
GridMetrics [switches] groundfile heightbreak cellsize outputfile datafile1 

The syntax that will be used for this data set is: 
GridMetrics /minpts:1 /raster:count,mean demo_flat_ground.dtm 2 8.9916 
demo_gridmetrics demo_canopy_maxima.lda 

Explanation of Syntax: 
The /minpts switch controls the minimum number of points that have to be in a cell to 
have metrics computed, this sets it to a minimum of 1. The /raster switch creates .dtm 
files for the count of points in a cell (stem density) and the average value for the points in 
the cell (in this case, height). The heightbreak is set to 2 and the cell size is set to the 
standard 8.9916 for the output cell size.

1. Copy and paste the syntax give above into the command prompt window and 
press “enter”. This will start the batch program, and may take a while to run 
depending on your computer. Status information will be displayed as the program 
runs.
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DTM2TIF Tool:

This tool has been described in the earlier section of this manual, so only the syntax 
needed for this section will be provided. This tool converts dtm files to geo tiff files with 
the associate world file. 

General Syntax: 
DTM2TIF [switches] inputfile [outputfile] 

The syntax that will be used for this data set: 
Stem density: 
DTM2tif demo_gridmetrics_first_returns_density_only_elevation_count.dtm 
demo_stem_density.tif 
Average Height: 
DTM2tif demo_gridmetrics_first_returns_density_only_elevation_mean.dtm 
demo_avg_height.tif 

Congratulations! You are now finished with the data generation portion of this 
tutorial. The next step will be image segmentation and classification with SPRING. 
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The files that were generated in this part will be located in the C:\FUSION directory 
and will be needed for the next section. 
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Part III- Segmentation and Classification with SPRING

This portion of the tutorial will deviate from the step by step nature of the previous 
sections. Image classification is a process that is dependant on the individual analyst and 
there are multiple ways to segment, train and classify the same image. This section will 
use a tutorial developed by the US Fish and Wildlife Service in their remote sensing lab 
in Albuquerque, New Mexico.

Software needed: 
� SPRING (see downloads section)

Data Required: 
� Percent cover (demo_cover_89916m.tif) 
� Stem density (stem_density.tif) 
� Average height (avg_height.tif) 

Other Downloads 
� USFWS tutorial: http://www.fws.gov/data/documents/SPRING%20Manual%20022306.pdf

Download for this section: 
For this section a tutorial developed by the U.S. Fish and Wildlife Service will be 
used. This tutorial was chosen to be used in this manual because it covers the basic 
functionalities of SPRING and image classification. The tutorial is also basis for the 
method used in this project. The primary focus of this section of the manual will be 
as a guide through the USFWS tutorial and explanation of known problems with 
SPRING. The information in this section is intentionally vague. The parameters for 
segmentation, classes and training sites are subjective and will vary greatly 
depending on the goals and skill of the analyst. This section is meant to be a rough 
guide to object orientated classification using SPRING.

1. Download the USFWS SPRING tutorial from: 
http://www.fws.gov/data/documents/SPRING%20Manual%20022306.pdf

2. Print or save the USFWS tutorial for use in the next section. 

Section I: Guide through the USFWS SPRING tutorial:

This section will go through each part of the USFWS tutorial, numbers correspond to the 
tutorial sections. 

2.1 Download and install SPRING- See download section of this manual 
2.2 Acquire and Install ERDAS ViewFinder- Not necessary for this project.
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2.3 Reproject and Resample Imagery with ERDAS ViewFinder- Not

necessary, projections set in ArcMap 
2.4 Create Database, Project Category and Import Image- Follow these 

instructions as is. Name the database and project relevant to the data.  Set the 
bounds to the extent of the geo tiff images created in FUSION. Set the projection 
to UTM WGS84 zone 10 north. See note below about importing images into 
SPRING.

*Note about importing images-
SPRING is very particular about the format of the files it will import. Geo tiff files with 
associated world files are necessary. In addition, the size of the geo tiff files and origin in 
the world file must match EXACTLY. Depending on the outputs that are generated from 
the FUSION analysis, there may need to be some adjustment to the size or origin 
information listed in the world file. There are several programs that manipulate the size 
of images, so this process will not be covered in this manual. To edit world files, simply 
open the .tfw files associated with the geo tiff files and edit them accordingly in notepad. 
It is also important that the geo tiff images have the projection defined before bringing 
them into SPRINg. This can easily be done through ArcMap in the data management -> 
projections ->define projection tool in the toolbox.
SPRING as released in the version for this manual will only accept geo tiff images. The 
functionalities shown in the File menu on the main SPRING menu do not work. There is 
no documentation as to why this occurs.*

2.5 Create Segmentation- Follow these instructions as is. The values for similarity 
and area will vary depending on the purpose of the classification. Try several 
combinations to see the difference. For this dataset a similarity of 5 and area of 10 
produce decent results. 

2.6 Create Classes for Classification, Training Samples Collection- Again this 
section can be followed as is. Create class names that reflect the type of 
classification that is desired. The training sites will be dependant on the classes 
that are chosen. The aerial photograph of the study site (demo_4800K_UTM.jpg) 
may be helpful to determine classes and location of training sites.

2.7 Run Training Sample Analysis, Classification and Output Map- Follow
instructions as is. If classification is not satisfactory, return to the previous section 
and edit the training or segmentation and re-run the classification.

2.8 Create Vector- Follow instructions as is. Save the shapefile to a directory 
relevant to the tutorial. 

2.9  Export Thematic Map- The view the output shapefile, open ArcMap and add in 
the shapefile to a project with the demo_4800K_UTM.jpg image already loaded.

*Note about shapefiles- SPRING has a defect that adds 10,000,000 units to the Y 
coordinates of the output shapefile. This can be corrected by using the “Move” tool in the 
editor of ArcMap. Subtract 10,000,000 units from the Y axis and the shapefile for the 
classification should line up. *

2.10 Add Projection, Reproject, Load into GIS- Projection will need to be defined 
for the shapefile in ArcMap in the data management -> projections ->define 
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projection tool in the toolbox. The projection should be set to UTM NAD 
1983 NADV 88 zone 10 north. 

Part IV: Accuracy Assessment of Classified Images

This is the final section of the tutorial and briefly describes how to perform an accuracy 
assessment on classified images using a confusion matrix. For a full description of the 
theory and methods please see: 
Congalton, R.G and K. Green (1999). Assessing the Accuracy of Remotely Sensed Data: 

Principles and Practices. Boca Raton, FL, Lewis Publishers. 

Software needed: 
� Hawth’s Tools (see downloads section)
� ArcMap 9.2

Data Required: 
� Output of SPRING classification (shapefile) 
� Aerial Photograph (demo_4800K_UTM.jpg and demo_4800K_UTM.jpgw) 
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 Section I: Setting up a sampling grid and points
As mentioned in the introduction to this part, only the set up for the accuracy assessment 
will be covered. This is primarily because this is only one method of accuracy assessment 
for classifications and is also described in detail in Congalton and Green’s book. 

Create a Grid: In order to see the individual pixels, a grid must be created to distinguish 
pixels.

1. Open ArcMap with and navigate to the project used for the tutorial. 
2. Open the extensions menu and turn on the toolbar for Hawths Tools 
3. Open Hawths tools and navigate to Sampling tools-> Create Vector Grid 

4. In the dialogue box that pops up, set the extent to the “Same as Layer” and 
choose the demo_4800K_UTM.jpg from the drop down menu. Under the 
“Parameters” section, set the spacing between lines to 8.9916, and 
uncheck the two boxes. Under “Output”, choose the destination and name 
of the output grid. In this example it is called 89916_grid.shp. Click the 
button next to the “Projection Definition” to set the projection (see next 
step).
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5. When the dialogue box below appears, choose “Import” and navigate to 
the folder where the demo_4800K_UTM.jpg file is on your computer. 
Select this file and click “add” the menu on the right will appear showing 
that the projection has been set to NAD_1983_UTM_Zone_10N. Click 
“Next” and then “Finish” on the next screen. 

6. Once the projection is set, click “ok” from the Create Vector Grid menu to 
run the program. When the processing is finished, the layer will be added 
to the project. 

First
dialogue box 

Second
dialogue box 

Click here to 
define the 
projection.
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7. To view the grid, double click on the grid layer and set the fill to 
“hollow”, the line color to red and the outline width to 1.

8. To create the point layer that will be used to as the sampling grid for the 
accuracy assessment, open the Hawth’s tools extension and navigate to 
Sampling tools -> Create a regular grid to open the tool. 

9. In the “Input” section choose the Extent to be Same as the 89916_grid.shp 
layer from the drop down menu. In the “Points” section enter 50 for the 
point spacing. Choose the alignment of rows as follows and name the 
output file 50m_points.shp and click “ok”. When processing is finished, 
the layer will be added to the project. 
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Section II – Accuracy Assessment

Now that the analysis grid and sample point layers have been created, the accuracy 
assessment can be performed on the classification. This process is dependant on the 
preferences of the analyst and data that is available. In the case of this tutorial, sample 
point spacing was chosen to give approximately 100 samples per class with extra points 
included to account for pixels that have multiple classes.  

The basic concept of this accuracy assessment method is to compare the classification of 
the pixels that contain a sample point to the aerial photograph to determine if the 
classification is correct. The accuracy of this method is highly dependant on the analyst’s 
ability to determine classes from aerial photographs. Each of the sample point pixels will 
then build the error matrix that will be the basis for calculating the user’s accuracy, 
producer’s accuracy, overall accuracy and KHAT (Congalton and Green, 1999). 


